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1. When three hyphens, underscores, equal signs, asterisks, or number signs 
are typed and then the enter key is pressed, the Auto Format feature _____? 
(A) Place a border above a paragraph 
(B) Creates a numbered list 
(C) Changes the characters to an em dash 
(D) Creates a bulleted list 
 
2. Microsoft Office Word is a (n)____? 
(A) Area in the computer’s main memory in which Microsoft Office text files 
are stored temporarily 
(B) Program included with Windows 2000 that can be used only to create or 
 edit text files, smaller than 64K, that do not require formatting 
(C) Classified password that prevents unauthorized users from accessing a 
protected Microsoft Office item or document 
(D) Full-featured word processing program that can be used to create and 
revise professional looking documents easily 
 
3. Ctrl + E is used for? 
(A) Exit application 
(B) Select all 
(C) Clear all 
(D) Align center 
 
4. When a custom tab stop is set, Word___? 
(A) Clears all default tab stops 
(B) Clears all default tab stop to the right of the custom tab stop 
(C) Clears all default stops to the left of the custom tab stop 
(D) Does not clear any default tab stops 
 
5. When inserting page number in footer it appeared 1 but you wish to show a. 
How can you do that? 
(A) Form format menu choose bullets and numbering and configure necessary 
setting 
(B) Form insert menu choose page number ad specify necessary setting 
(C) Click on page number format tool and specify requires setting 
(D) All of the above 
 
6. How do you close a word document without closing Word window? 
(A) Click on the close button on the title bar 
(B) Click on X minimize button on the title bar 
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(C) Click on the close command on Office menu 
(D) Click exit on the file menu 
 
7. To switch between insert mode and over type mode,______? 
(A) Click caption on the insert menu 
(B) Double click the OVR status indicator on the status bar 
(C) Click text box on the insert menu 
(D) Double click the INS status indicator on the status bar 
 
8. What should you do if you required to paste the same format in many 
pages? 
(A) Click the format and go on pasting in many places holding Alt key 
(B) Double click the format painter then go on pasting to many paces  
(C) Click the format painter then go on pasting to many places holding Ctrl key 
(D) All of the above  
 
9. Which would you choose to save a document with a new name? 
(A) Press ctrl + s 
(B) Click file, save 
(C) Click tools, options, save 
(D) Click file, save as 
 
10. You cannot close MS Word application by? 
(A) Choosing file menu then exit sub menu 
(B) Pressing Alt + F4 
(C) Click X button on the title bar 
(D) From file menu choose close sub menu 
 
11. Which of the following option is not available in insert -> picture? 
(A) Chart 
(B) Word art 
(C) Clip art 
(D) Graph 
 
12. Which option in file pull down menu is used to close a file in MS Word? 
(A) New 
(B) Quit 
(C) Close 
(D) Exit 
 
13. Ctrl + o is used for? 
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(A) Save document 
(B) New document 
(C) Print document 
(D) Open document 
 
14. Which feature do you use to create a newspaper like document? 
(A) Bullets and numbering 
(B) Tables 
(C) Columns 
(D) Tab stops 
 
15. A_____ contains buttons, boxes and menus that allows tasks to be 
performed more quickly than using the menu bar? 
(A) Format bar 
(B) Status bar 
(C) Command bar 
(D) Toolbar 
 
16. A letterhead should contain all of the following except? 
(A) Full street address 
(B) Logo 
(C) Complete legal name of the company, group, or individual 
(D) None of the above 
 
17. Which of the following is not available in font spacing? 
(A) Normal 
(B) Loosely 
(C) Condensed 
(D) Expanded 
 
18. To convert a hyperlink email address to regular text, right click the email 
address and then click_______? 
(A) Edit hyperlink 
(B) Select hyperlink 
(C) Convert hyperlink 
(D) Remove hyperlink 
 
19. Which enables you to move directly to specific location in a document? 
(A) Sub document 
(B) Bookmarks 
(C) Cross references 
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(D) All of the above 
 
20. Each time the ______key is presses, the paragraph formatting in the 
previous paragraph is carried forward to the next paragraph? 
(A) Enter 
(B) Shift 
(C) Ctrl 
(D) Alt 
 
21. What is the shortcut key you can press to create a copyright symbol? 
(A) Alt + ctrl + c 
(B) Alt + c 
(C) Ctrl + c 
(D) Ctrl + shift + c 
 
22. What is the shortcut key to open font dialog box? 
(A) Ctrl + f 
(B) Alt + ctrl + f 
(C) Ctrl + d 
(D) Ctrl + shift + d 
 
23. What is the shortcut to “center align” the selected text? 
(A) Ctrl + c 
(B) Ctrl + e 
(C) Ctrl + f 
(D) All of the above 
 
24. What is the shortcut key for spelling check in document? 
(A) F7 
(B) Shift + F7 
(C) Ctrl + F7 
(D) Alt + F7 
 
25. What is the shortcut key to update formula in a table? 
(A) F9 
(B) Alt + F9 
(C) Shift + F9 
(D) Ctrl + F9 
 
26. What is the shortcut key for font dialog box? 
(A) Ctrl + f 
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(B) Ctrl + d 
(C) Ctrl + g 
(D) None of these 
 
27. What is the shortcut key for “find and replace” dialog box? 
(A) Ctrl + f 
(B) Ctrl + r 
(C) Ctrl + h 
(D) Ctrl + shift + f 
 
28. What is the shortcut key to “insert hyperlink” in a document? 
(A) Ctrl + h 
(B) Ctrl + f 
(C) Ctrl + k 
(D) Ctrl + o 
 
29. How can you access the font size tool on formatting toolbar? 
(A) Ctrl + s 
(B) Ctrl + shift + s 
(C) Ctrl + p 
(D) Ctrl + shift + p 
 
30. What is the shortcut key for “subscript” the selected text? 
(A) Ctrl += 
(B) Ctrl +- 
(C) Ctrl +/ 
(D) Ctrl + shift += 
 
31. How many different positions can you set drop cap in MS Word 
document? 
(A) 1 
(B) 2 
(C) 4 
(D) 6 
 
32. How many ways you can save in MS Word document? 
(A) 3 
(B) 4 
(C) 5 
(D) 6 
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33. What is the maximum number of lines you can set for lines to drop box? 
(A) 3 
(B) 5 
(C) 10 
(D) 15 
 
34. Single spacing in MS Word document causes______ point line spacing? 
(A) 10 
(B) 12 
(C) 14 
(D) 16 
 
35. What is the default number of lines to drop for drop cap? 
(A) 3 
(B) 10 
(C) 15 
(D) 20 
 
36. What is the maximum number of lines you can set for a drop cap in MS 
Word document? 
(A) 3 
(B) 10 
(C) 15 
(D) 20 
 
37. How many maximum columns can you insert in a word document? 
(A) 35 
(B) 45 
(C) 55 
(D) 65 
 
38. In a MS Word document what is the maximum number of columns that 
can be inserted in a table? 
(A) 35 
(B) 15 
(C) 63 
(D) 65 
 
39. What is the maximum scale percentage available in scale drop down box? 
(A) 500 
(B) 200 
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(C) 100 
(D) 90 
 
40. What is the maximum font size you can apply for any character in MS 
Word document? 
(A) 163 
(B) 1638 
(C) 16038 
(D) None of the above 
 
41. In MS Word, by default places a tab stop at every____ mark the ruler? 
(A) .25” 
(B) .5” 
(C) .75” 
(D) 1” 
 
42. What is the default file extension for all word documents? 
(A) .txts 
(B) .word 
(C) .docs 
(D) .docx 
 
43. The file type ________indicates the files is a word document? 
(A) .msw 
(B) .wor 
(C) .wrd 
(D) .doc 
 
44. With word’s auto correct entries, to display an indifferent face (“|) type? 
(A) :) 
(B) :( 
(C) :| 
(D) :/ 
 
45. Which of the following button will allow you to add, delete, or change 
records in your data source? 
(A) ‘Data source’ button 
(B) ‘Edit’ button 
(C) ‘Edit data source’ button 
(D) ‘Data editing’ button 
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46. How much space in minimum must be provided between columns? 
(A) 0” 
(B) 0.5” 
(C) 1” 
(D) 1.5” 
 
47. What is the smallest width of a column? 
(A) 0” 
(B) 0.5” 
(C) 1” 
(D) 1.5” 
 
48. By default, MS Word document prints with? 
(A) 1 inch top and bottom margins 
(B) A portrait orientation 
(C) 1.25 inches left and right margins 
(D) All of the above 
 
49. MS Word is preset to use standard 8.5-by-11 inch paper with margin? 
(A) 1 inch left, right, top and bottom margins 
(B) 1.25 inch left, right, top and bottom margins 
(C) 1.25 inch left and right margins and 1inche top and bottom 
(D) 1 inch left and right margins and 1.25 inch top and bottom 
 
50. What is the default left margin in MS Word 2003 document? 
(A) 1” 
(B) 1.25” 
(C) 1.5” 
(D) 2” 
 
51. What is the smallest and largest font size available I font size tool on 
formatting toolbar in MS Word? 
(A) 8 and 72 
(B) 8 and 64 
(C) 12 and 72 
(D) None of these 
 
52. The footnote text style defines characters as? 
(A) 12 point times new roman and paragraph as single spaced and right 
aligned 
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(B) 10 point times new roman and paragraph as double spaced and left 
aligned 
(C) 12 point times new roman and paragraph as double spaced and right 
aligned  
(D) 10 point times new roman and paragraph as single spaced and left 
aligned 
 
53. What is the default font size of a new MS Word document based on 
normal template? 
(A) 10 pt 
(B) 12 pt 
(C) 14 pt 
(D) None of the above 
 
54. The minimum number of rows and columns in MS Word document is? 
(A) 1 and 1 
(B) 2 and 1 
(C) 2 and 2 
(D) None of the above 
 
55. How will MS Word will respond in repeated word? 
(A) A red wavy line under the repeated word 
(B) A green wavy line under the repeated word 
(C) A blue wavy line under the repeated word 
(D) None of the above 
 
56. In mail merge operation which of the following might represent the main 
document? 
(A) A sales brochure 
(B) A form letter 
(C) A database of names and addresses 
(D) All of the above 
 
57. Pressing F8 key for three times selects? 
(A) A word 
(B) A sentence 
(C) A paragraph 
(D) Entire document 
 
58. What do you call a collection of character and paragraph formatting 
commands? 



IT Quiz MCQ PDF 

DAILY HIMACHAL GK 

(A) The defaults 
(B) A template 
(C) A style 
(D) A boilerplate 
 
59. What is a document outline view? 
(A) A preview in a full screen 
(B) A preview with margins 
(C) A view with a margins and gutter 
(D) A view with a structure of heading at various levels 
 
60. Ctrl + z is used for? 
(A) Undo the last action 
(B) Redo the last action 
(C) Add the new page 
(D) Paste the contents from clipboard 
 
61. The______ in the resume wizard dialog box indicates the wizard is ready 
to create the document? 
(A) Start panel 
(B) Address panel 
(C) Add/sort heading panel 
(D) Finish panel 
 
62. What does ctrl + = key effect? 
(A) Superscript 
(B) Subscript 
(C) All Caps 
(D) Shadow 
 
63. The spike? 
(A) Allows you to combine text from several documents and then insert all the 
text into one document at one time 
(B) Allows you to edit auto text entries 
(C) Allows you to format the text entries 
(D) All of the above 
 
64. The word wrap reature? 
(A) Automatically move text to the next when necessary 
(B) Appears at the bottom of the document 
(C) Allows you to type over text 
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(D) Is the short horizontal text 
 
65. How can you make the selected character superscripted? 
(A) Ctrl += 
(B) Ctrl + shift + = 
(C) Alt + ctrl + shift + = 
(D) None of these 
 
66. When typing in a word file manually, what must you press to insert the 
code’s braces? 
(A) Ctrl + F6 
(B) Ctrl + F9 
(C) Ctrl + F11 
(D) Shift + F12 
 
67. What is the shortcut key to open the dialog box in MS Word? 
(A) F12 
(B) Shift + F12 
(C) Alt + F12 
(D) Ctrl + F12 
 
68. What is the shortcut key to split a table? 
(A) Ctrl + alt + enter 
(B) Ctrl + shift + enter 
(C) Alt + shift + enter 
(D) Alt + space + enter 
 
69. Which key is used to increase left indent? 
(A) Ctrl + l 
(B) Ctrl + M 
(C) Alt + l 
(D) F10 
 
70. When the same word is used in multiple locations or a word is used that 
was not quit appropriate, a thesaurus can be used to look up a (n)__ or a 
word similar in meaning? 
(A) Synonym 
(B) Homonym 
(C) Antonym 
(D) Metronym 
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71. How many different documents you can open at one time? 
(A) No more than three 
(B) Only one 
(C) As many as your computer memory will hold 
(D) As many as your taskbar can display 
 
72. Which of the following is the second step in creating a macro? 
(A) Start recording 
(B) Using your mouse or keyboard, perform the task you want to automate 
(C) Assign a keyboard shortcut to the macro 
(D) Give the macro a name 
 
73. When assigning a shortcut key to a symbol, you should always try to 
select a key or key combination that is? 
(A) Unassigned 
(B) Located on the ten-key pad section of your keyboard 
(C) Assigned to another task 
(D) From the same font family as the symbol 
 
74. Which feature is used to replace straight quotes with smart quotes as you 
type? 
(A) Auto correct as you type 
(B) Auto change as you type 
(C) Auto format as you type 
(D) Smart tags as you type 
 
75. Which of the following command is not available in tools menu? 
(A) Auto text 
(B) Autocorrect 
(C) Auto summarize 
(D) Macro 
 
76. Word has a list of predefined typing, spelling, capitalization anfd grammar 
errors that _______ can detect and correct ? 
(A) Auto entry 
(B) Autocorrect 
(C) Auto add 
(D) Auto spell 
 
77. If you want to convert a symbol or several lines of text into an autocorrect 
entry, you should? 
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(A) Insert the symbol or type the text in a word document first. Then select the 
text or symbol and go to the autocorrect dialog box 

(B) Click the Tools menu and choose AutoCorrect Options. Then, 
click the Insert menu and choose Symbol (or click the Format 
menu and choose Paragraph) to add the symbol or paragraph to 
AutoCorrect 
(C) AutoCorrect can only accommodate one line of text. It is not 
possible to convert a symbol or multiple lines of text into an 
AutoCorrect entry 

(D) Insert the symbol or type the text in a Word document first. 
Then, select the text or symbol and click the Edit menu followed 
by Paste Special. Select New AutoCorrect Entry and then click 
OK 

 
78. Which option is not available in insert table autofit behavior? 
(A) Fixed column width 
(B) Autofit to contents 
(C) Autofit to window 
(D) Autofit to column 
 
79. When you click on file menu on Word 2010, it opens? 
(A) File menu 
(B) File commands 
(C) Backstage view 
(D) File ribbon 
 
80. Tabs stop position cannot be the following alignment? 
(A) Decimal alignment 
(B) Center alignment 
(C) Bar alignment 
(D) Justify alignment 
 
81. Why the MS document you created at home displays with a different font 
at school? 
(A) Because you have a different printer at school than at home 
(B) Because you have a different monitor at school than at home 
(C) Because the font you used at home is not installed on your school 
computer 
(D) Because the version of windows is different 
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82. Ctrl + b is used for? 
(A) Search the selected text 
(B) Paste the selected text 
(C) Bold the selected text 
(D) Open the specified file 
 
83. A master document contains______, each of which contains a pointer to a 
file on a disk in MS Word? 
(A) Placeholders 
(B) Subdocuments 
(C) Bookmarks 
(D) References 
 
84. In MS Word file if the number of columns is selected 1 and the line 
between checkbox is marked, where is the line drawn? 
(A) In the left margin 
(B) In the right margin 
(C) Both in left and right margin 
(D) None of the above 
 
85. A feature of MS Word that saves the document automatically after certain 
interval is available on? 
(A) Save tab on options dialog box 
(B) Save as dialog box 
(C) Both of the above 
(D) None of the above 
 
86. After typing header text, how can you quickly enter footer text? 
(A) Press page down key and type the text for footer 
(B) Click on switch between header and footer then type the text 
(C) Both A and B 
(D) None of these 
 
87. In MS Word to move the cursor page to page of document? 
(A) Ctrl + page down 
(B) Ctrl + page up 
(C) Both A and B 
(D) None of above 
 
88. You can jump to the next columns by? 
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(A) Clicking with your mouse on the next column 
(B) Press alt + down arrow 
(C) Both A and B 
(D) None of the above 
 
89. In MS Word, which of the following enables you to paste data multiple 
times? 
(A) Windows clipboard 
(B) Office clipboard 
(C) Both windows & office clipboard 
(D) None of the all 
 
90. You need to jump to the next column breaking current column right at the 
cursor position. How can you break column in MS Word? 
(A) Pressing ctrl + enter 
(B) Pressing alt + shift + enter 
(C) Break command from insert menu 
(D) Both B and C 
 
91. in MS Word you can force a page break? 
(A) By positioning your cursor at the appropriate place and pressing the F1 
key 
(B) By using the insert/selection break on the insert tab  
(C) By positioning your cursor at appropriate place and pressing ctrl+enter 
(D) By changing the font size of the document 
 
92. How can you increase the font size of selected text by one point? 
(A) By pressing ctrl + ] 
(B) By pressing ctrl + [ 
(C) By pressing ctrl + } 
(D) By pressing ctrl + { 
 
93. How to use format painter multiple times? 
(A) By clicking on lock format painter icon 
(B) By double click on format painter icon 
(C) By selecting edit > format painter > multiple use 
(D) Format painter cannot be use multiple times 
 
94. What is the default font used in MS Word 2007 document? 
(A) Times New Roman 
(B) Arial 
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(C) Calibri 
(D) Preeti 
 
95. MS Word includes a series of predefined graphics called______ that can 
be inserted into a Word document? 
(A) Clip art 
(B) Hyperlink 
(C) Captions 
(D) Bookmarks 
 
96. A(n)____is a dot or other symbol positioned at the beginning of a 
paragraph? 
(A) Bullet 
(B) Logo 
(C) Cell 
(D) Target 
 
97. Which of the following is not a type of page margin? 
(A) Left 
(B) Right 
(C) Center 
(D) Top 
 
98. Uppercase on change case dialog box and all caps on fonts dialog box 
both converts selected text into capital letters. What’s the different between 
the two? 
(A) Both are same. They are only two different ways of capitalize text 

(B) It is faster to convert from Change Case than from Font dialog 
box 

(C) Change Case makes conversion permanent but All Caps on 
Font can always be reverted 

(D) All Caps on Font dialog box makes the change permanent 
where Change Case can be always reverted 

 
99. Ctrl + a is used for? 
(A) Align right 
(B) Select all 
(C) change font 
(D) Save document 
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100. Which of the following is not on home ribbon? 
(A) Columns 
(B) Font color 
(C) Change style 
(D) Font 
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Answer 
 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

A D D C C C B B D D D C D C D 

16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 

D B D B A A C B A A B C C D A 

31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 

B A C B A B B C B B B D D C C 

46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 

A B D C B A D B A A A B C D A 

61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 

D B A A B B D B B A C D A C A 

76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 

B A D C D C C B D A C C C C C 

91 92 93 94 95 96 97 98 99 100 
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C A B C A A C C B A 
      


